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1 Current Version and History 

1.1 New Functions 

The following table lists the new functions and indicates the version in which the new 

function was introduced: 

New Functions in Software V1.80 

Version Function 

V1.80 Supports 40 GSa/s mode of R&S®RTP134-K11 and R&S®RTP164-K11 

V1.80 Supports Trigger mode "Manual" for R&S®RTO and R&S®RTP devices. See manual for more 
details. 

V1.80 Supports RF-Power trigger when connected to R&S®FSV3000. Requires R&S®FSV3000 
firmware V1.30 or newer. 

V1.80 Supports loading of IQ files with just I components instead of the usual I&Q. 

V1.80 R&S VSE-K100: Supports Custom Sync Weight for P-/S-sync. 

V1.80 R&S VSE-K100: Supports Suppress Interferer for Synchronization. 

V1.80 R&S VSE-K100/K106: Supports "Layer EVM" in Allocation Summery (Downlink only).  

V1.80 R&S VSE-K100/K106: Supports modulation type information for 2D result displays in marker 
result (Downlink only).  

V1.80 R&S VSE-K106: Supports "After MIMO/CDMA Decoder" filter for Constellation result. 

V1.80 R&S VSE-K106: Supports "MIMO Compensate Crosstalk" setting in Demodulation dialog. 

V1.80 R&S VSE-K106: Supports "NB-IoT Power" in Result Summary for Stand-alone and 
Guardband modes. 

V1.80 R&S VSE-K144: 
Signal demodulation and analysis in line with TS38.211 V15.8.0 
Test models in line with TS38.141-1/2 V15.5.0 
ACLR/SEM in line with 38.141-1/2 V15.4.0 and 38.521-1/2 V15.3.0 
On/Off power measurements in line with 38.141-1/2 V15.4.0 
Inband Emission limit check for FR1/FR2 according to 38.521-1/2 V15.3.0 
Equalizer spectrum flatness limit check in line with 38.521-1/2 V15.3.0 
Frequency error limit check in line with 38.141-1/2 V15.4.0 and 38.521-1/2 V15.3.0 
UL measurement mode PRACH Analysis 
LTE-CRS Coexistence  
Analysis of multiple CSI RS resources 
CSI periodicities greater than one frame 
Half frame offset for synchronization signals 
PRB bundling combining PDSCH allocations with same user ID 
PDSCH VRB to PRB mapping 
PDSCH reference data "All 0" or "PRS23" 
Transport block scaling factor 
Timing position EVM_h and EVM_L as EVM calculation method  
Fixed CC offset for easier multi component carrier configuration 
Slotwise calculation of result summary 
EVM peak in result summary 
Configuration of multiple BWPs with same SCS in UL 
Frame start offset in result summary 

V1.80 R&S VSE-K6: Support for segmented capture with a compatible oscilloscope. See datasheet 
for more details. 

V1.80 R&S VSE-K6: First release of R&S VSE-K6A Phased Array Measurements option, providing 
multi-channel pulse measurements with a supported oscilloscope.  See manual or datasheet 
for more details. 

V1.80 R&S VSE-K544: Supports multi-channel input with R&S VSE-K6A Phased Array 
Measurements option. 

V1.80 R&S VSE-K70: Improved burst search for low reference levels. 



Version Function 

V1.80 R&S VSE-K70: Improved coarse synchronization for 64APSKs. 

V1.80 R&S VSE-K70P: Additionally supported PRBS types 7 and 31. 

V1.80 R&S VSE-K96: Support DFT-S OFDM / SC-FDMA / Transform Precoding. 

V1.80 R&S VSE-K96: Data for K96 Configuration File Wizard can now be exported directly by the 
VSE-K96. This allows the user to create the K96 xml configuration file later or on another PC. 

V1.80 R&S VSE-K96: New SCPI commands to query the Peak EVM values for all symbols, only the 
pilot symbols and only the data symbols. 

V1.80 VSE-K96 Configuration File Wizard: A cell region in the frame matrix or allocation matrix can 
now be selected more easily by directly entering the desired symbol and carrier range. 

New Functions in Software V1.70 

Version Function 

V1.70 VSE installer supports automatic de-installation of previous versions. 

V1.70 Toolbar has a new button to start an external application 

V1.70 Supports R&S®IQW. 

Support is based on the .iqx file format and incudes the selection of recorded trigger 
information for post analysis.  

V1.70 Supports R&S®NRQ6 

V1.70 Supports R&S®FSW-B21 

V1.70 Supports R&S®RTP134 and R&S®RTP164 

V1.70 Supports R&S®RTP-K11 including support for the following R&S VSE options: 

K10, K71,K91,K91p,K91n,K91ac, K100,K102,K014,K016,K144,K146 

V1.70 Supports R&S VSE-K146 5G-NR MIMO Measurements 
R&S VSE-K146: Supports phase-coherent measurements of multiple input sources with 
R&S®RTO, R&S®RTP, R&S®NRQ 

V1.70 R&S VSE-K144: 
Signal demodulation and analysis in line with TS38.211 V15.6.0 
Supports CSI reference signal 
Supports SRS reference signal 
Supports PUCCH format 0/1 
Supports test models according to TS38.141-1/2 V15.2.0 
Supports configuration of PDCCH within CORESET (including interleaving) 
Supports PDCCH decoding (bitstream) 
Supports auto detection of signal configuration for BWP and SS/PBCH blocks  
Supports beamforming summary for phase measurements 
Supports "RS Phase" and "RS Phase Difference" display 
Supports CCDF result display 
Supports Frequency Error vs. Symbol display 
Supports inband emission measurement (without limit lines) 
Supports I/Q Offset, I/Q Gain Imbalance, I/Q Quadrature Error, OSTP, RSTP, CSI-RSRP, 
SS-RSRP in result summary 
Supports configuration of number of slots to analyze 
Supports analysis of short captures without trigger for repetitive signals (e.g. repeating slot 0) 
Supports Time and Level Tracking 
Supports phase tracking option "Pilot only" 
Supports EVM calculation method “at optimal timing position” 
Supports long capture mode for capture times >= 50.1ms 
Supports EVM max hold functionality 
Supports compensation of carrier leakage 
Supports readable/modifiable .allocation file format 
Supports display of up to 16 component carrier results at once in result summary 
Supports custom configuration of parameters displayed in result summary 
Supports DMRS only selection for PDSCH allocations 
Supports CORESET interleaving shift index “Cell ID” 
Supports CORESET start as reference point for CORESET DMRS 
Supports BWP start as reference point for PDSCH DMRS 
Supplies updated VSE demo files 
Supports analog baseband input via R&S RTO 

V1.70 R&S VSE-K6: 



Version Function 

New Pulse-Pulse Spectrum display useful for Doppler measurements.  

New user-definable detection range for analyzing a subset of the acquisition.  

New fixed-level algorithm for pulse envelope measurements.  

Incorporation of trigger position in sample into timestamp values for better resolution with 
external trigger. 

The overall measured pulse count is now shown in the Pulse Results table header and per 
parameter as an extra row in the Pulse Statistics table. 

V1.70 R&S VSE-K70: 

Density trace mode for polar displays and eye diagram 

Auto-refresh functionality in Run Single mode 

Supports equalizer data in Frequency Response Correction format .fres for K544. 

New mapping "Gray" for pi/4-QPSK 

New mapping "SMx" for pi/8-D8PSK and pi/4-DQPSK 

New predefined standard: GBAS (Ground Based Augmentation System) 

"Channel Bar" now displays more setting parameters. 

Various new SCPI commands that facilitate the handling of e.g. burst/pattern search 
scenarios, bit error rate measurements. 

QAMs with orders up to 16,384 can now be used. 

Supports input of encrypted *.wv files. 

Only relevant with connected R&S®FPL1-K70: For sample rates lower than or equal to 
6.25 MHz, the SAW filter can now be deactivated. Before, it was always active for sample 
rates lower than or equal to 6.25 MHz. Deactivating the SAW filter can improve the residual 
EVM. 

V1.70 R&S VSE-K96: "Channel Bar" now displays more setting parameters. 

V1.70 R&S VSE-K544: Supports multiple stream input for 5G-NR MIMO measurements 

New Functions in Software V1.62: 

Version Function 

V1.62 Supports 20 GHz sample rate for R&S® FSW 

V1.62 Supports R&S® FPL1007 and R&S® ZNL6 devices 

V1.62 Supports R&S® FSV3000 and R&S® FSVA3000 

New Functions in Software V1.61: 

Version Function 

V1.61 Supports R&S® ETL-K470 CDR (Convergent Digital Radio) license 

V1.61 R&S VSE-K70: Supports sub-option R&S VSE-K70M for multi-modulation analysis (requires 
separate option key) 

V1.61 R&S VSE-K70: Supports sub-option R&S VSE-K70P for bit error rate measurements with 
PRBS (requires separate option key) 

V1.61 R&S VSE-K70: Supports new Bluetooth standards Bluetooth_5_LE_S2 and 
Bluetooth_5_LE_S8 

V1.61 R&S VSE-K70: The error vector trace can now be exported to an iq-tar file. This allows for 
carrier-in-carrier measurements 

V1.61 R&S VSE-K70: The maximum available I/Q bandwidth can now be queried with 
TRAC:IQ:BWIDTh? MAX. 

V1.61 R&S VSE-K70: New SCPI command that allows for querying the capture length in symbols: 
:SENSe:DDEMod:RLENgth:SYMBols:VALue? 

 

 

 



New Functions in Software V1.60: 

Version Function 

V1.60 Supports floating licenses 

V1.60 Supports R&S VSE-K144 5G-NR uplink & downlink measurements 
(in line with TS38.211 15.2.0) 

V1.60 Support for R&S® RTP 

V1.60 Support for *.wv files in the following applications: 

I/Q Analyzer,K6, K7 ,K60,K72,K96, K100-K104,K106 

V1.60 Support for: 
R&S® FSW8, order no. 1331.5003K08, R&S® FSW13, order no. 1331.5003K13, 
R&S® FSW26, order no. 1331.5003K26, R&S® FSW43, order no. 1331.5003K43, 
R&S® FSW50, order no. 1331.5003K50, R&S® FSW67, order no. 1331.5003K67, 
R&S® FSW85, order no. 1331.5003K85 

V1.60 I/Q Analyzer: Support for gating on I/Q files, including continuous gate trigger with possibility 
for a detailed specification of the gating pattern 

V1.60 I/Q Analyzer & options support I/Q data input: 
For the input source “I/Q File”, a repetition number is supported which determines how often 
the data stream is copied in the I/Q data memory 

V1.60 R&S VSE-K106: New result “RB power excluding E-UTRA (dBm)” in result summary of 
downlink inband mode. This result is necessary to calculate the “NB-IoT RB power dynamic 
range” in 3GPP specification 36.141 chapter 6.3.3  

V1.60 R&S VSE-K544: Supports preview for selected file magnitude and phase, covered 
frequencies and combined frequency response for I/Q mode  

  



1.2 Modified Functions 

The following table lists the modified functions and indicates the version in which the 

modification was carried out: 

Modified functions of Software V1.80: 

Version Function 

V1.80 R&S VSE-K106: Renamed "RB Power Excluding EUTRA" to "NB-IoT Power" in Result 
Summary for Inband mode. 

V1.80 The maximum number of markers in an *.iqx files was previously unlimited. It is now limited to 
1000 markers. 

V1.80 The "10dB min" button in the GUI (only visible when connected to certain devices) has been 
moved from the "Input Source" dialog to the "Amplitude" dialog. 

V1.80 R&S VSE-K146: Cross talk compensation is steered via Conducted / OTA selection in 
measurement setup helper 

V1.80 R&S VSE-K146: Show frame start offset input source specific 

V1.80 R&S VSE-K144: Time Alignment restricted to multi layer configurations 

V1.80 R&S VSE-K144: In UL, antenna port mapping is extended for PUSCH DMRS 

V1.80 R&S VSE-K144: Renaming of Deploy frequency selections to "FR1 <= 3GHz", "FR1 > 3GHz" 
and "FR2" 

V1.80 R&S VSE-K144: Calculate OSTP according to R4-1916043 and R4-1916044 

V1.80 R&S VSE-K144: Renaming of "DMRS-Scrambling-ID" to "N_ID^DMRS" in PDSCH and 
"N_ID^PUSCH" to "N_ID^DMRS" in PUSCH enhanced settings 

V1.80 R&S VSE-K144: In specific scenarios, the PUSCH DMRS was moved to a different symbol 
for mapping type B. 

V1.80 R&S VSE-K70: After preset and for the predefined standard 3G_WCMDA.xml, the trace in the 
constellation diagram in window 1 is now a "Density" trace and no longer a "Clear Write" 
trace. This only affects the coloring of the trace. The trace values remain the same. 

V1.80 R&S VSE-K96: 

The calculation of the averaged MER value was changed.Originally, the average was taken 

over 
𝑃𝑖𝑑𝑒𝑎𝑙 𝑟𝑒𝑓𝑒𝑟𝑒𝑛𝑐𝑒 𝑠𝑖𝑔𝑛𝑎𝑙

𝑃𝑒𝑟𝑟𝑜𝑟 𝑣𝑒𝑐𝑡𝑜𝑟
 now, the average is taken over 

𝑃𝑒𝑟𝑟𝑜𝑟 𝑣𝑒𝑐𝑡𝑜𝑟

𝑃𝑖𝑑𝑒𝑎𝑙 𝑟𝑒𝑓𝑒𝑟𝑒𝑛𝑐𝑒 𝑠𝑖𝑔𝑛𝑎𝑙
 

 

V1.80 R&S VSE-K96: Renaming settings in dialog "Result Units". "Time Axes" was renamed into 
"Magnitude Capture" and "Frequency Axes" was renamed into "Power Spectrum", because it 
wasn't clear that these settings only apply to these results. 

V1.80 R&S VSE-K96: The result "Trigger to Sync" is no longer displayed in the channel bar. It can 
now be viewed in a separate result window. 

V1.80 R&S VSE-K91/N/AC: Signal Field result table has a new layout and includes all results 
according to the standard. 

Modified functions of Software V1.70: 

Version Function 

V1.70 VSE-K144: BWP (bandwidth part) minimum is now reduced to 1 RB (resource block) 

V1.70 VSE-K144: Replaced CORESET DMRS parameter “Sequence Generation / Scrambling” by 
“Use DMRS Scrambling ID” according to TS38.211 V15.6.0 

V1.70 VSE-K144: RF upconversion phase compensation according to TS 38.211 V15.4.0 5.4 is now 
activated by default 

V1.70 VSE-K144: Sampling rates of 15/30/60/70 MHz carrier bandwidth adapted according to TS 
38.141-1 V15.1.0 6.5.3 

V1.70 VSE-K144: Spectrum flatness in UL inverted according to 3GPP definition. 

V1.70 VSE-K70: Only relevant for capture lengths > 256,000 samples:  
Title of the window now indicates whether the entire capture buffer or only a section of the 
entire capture buffer is displayed. 



Version Function 

V1.70 VSE-K70: Only relevant for capture lengths > 256,000 samples:  
Lines in the Mag Overview (Capture Buffer) display now visualize which section of the 
capture buffer is displayed in windows that show only a part of the entire capture, e.g. 
Mag (Selected CB Section). 

V1.70 VSE-K70: Only relevant for capture lengths > 256,000 samples:  
Windows that display just a section of the capture buffer only support the trace modes 
“ClearWrite” and “View”. 

V1.70 VSE-K70: Improved layouts for the “Predefined Display Configurations” 

V1.70 VSE-K70: Up/Down increment for the capture length and result length parameters has been 
increased, both for the scroll wheel step size and for the corresponding SCPI commands. 

V1.70 VSE-K70: Adding/changing a result window triggers an auto refresh on the current capture 
buffer. The currently selected result range is then the last possible result range in the current 
capture buffer.  

V1.70 VSE-K70: The blue marker that highlights the currently analyzed result range in the capture 
buffer is now also displayed if there is only one result range in the capture buffer. 

V1.70 VSE-K70: The name of the default QPSK mapping has changed from “WCDMA” to “GRAY”. 
The mapping values themselves remain identical. Depending on the order of settings in a 
remote script, this might change the default mappings for other modulation schemes as well. 

V1.70 VSE-K96: Optimized layout for some dialogs. 

Modified functions of Software V1.61: 

Version Function 

V1.61 R&S VSE-K70: The "reset equalizer" button is now only active if the equalizer is in "Tracking" 
or "Averaging" mode. 

V1.61 R&S VSE-K70: Symbol errors that are detected in a bit error rate measurement are not 
highlighted with a red frame anymore, but are displayed in red text within the symbol table. 

V1.61 R&S VSE-K70: The "Digital Standards" menu entry has been moved from "File"->"Preset" to 
"Meas Setup" 

V1.61 R&S VSE-K70: PSK/QAM constellations are now always normalized to an RMS value of 1. 
This can lead to a different scaling of the results based on the measurement or reference 
signal, e.g. the I/Q constellation diagram. 

V1.61 R&S VSE-K70: The bit error rate result table can now be open, even if the bit error rate 
measurement is not active. 

V1.61 R&S VSE-K96: The result length can now be set automatically whenever a new configuration 
file is loaded. Whenever the parameter <DefaultResultLength> exists in the 
<GeneralParameters> group, this parameter is used as result length. 

  



1.3 Improvements 

The following tables list the improvements and indicate since which version the issue 

could be observed: 

Improvements of Software V1.80: 

since Function 

V1.70 When connected to an R&S®FSWP device, the following message appears on the device 
screen: -200 Execution error, option not available: SYST:COMM:RDEV:OSC:TCP 

This issue is solved. 

V1.70 When connected to an R&S®FSW with B24 option or R&S®FSV3000 with B24 option, the 
preamplifier step size of 15dB and/or 30dB was not recognized correctly under all 
circumstances. This issue is solved, but requires the firmware V4.70 or newer of the 
R&S®FSW and firmware V1.30 or newer of the R&S®FSV3000. 

V1.70 When connected to an R&S®FSW85 device, the second RF connector was not supported in 
VSE. This issue is solved. 

V1.70 R&S VSE-K144: No time alignment results were shown in certain scenarios with multiple 
PDSCH allocations. The issue is solved. 

  

V1.70 R&S VSE-K144: The PDCCH RNTI was restricted to a maximum of 3. The issue is solved. 

V1.60 R&S VSE-K144: In certain scenarios, the max trace in the EVM vs. carrier display showed 
spikes for a signal with added noise and utilizing 256 QAM modulation. The issue is solved. 

V1.70 R&S VSE-K91/N/AC: In case of measurement from file, inconsistencies with respect to the 
capture time were fixed. 

  

Improvements of Software V1.70 SP1: 

since Function 

V1.60 R&S VSE-K106: Uplink measurement didn't work with Basic Edition. This issue is solved. 

V1.70 R&S VSE-K91N: In case the Signal Field data was incorrect, the PPDU was discarded. This 
issue is fixed. 

V1.70 Running VSE directly on the device sometimes could cause the VSE to freeze in case a 
measurement parameter had been changed. This issue has been solved. 

V1.70 Connecting the VSE with an R&S® FSV3000 / R&S® FSVA3000 could lead to incomplete IQ 
captures. This issue has been solved, but requires R&S® FSV3000 / R&S® FSVA3000 
firmware 1.30 or newer. 

Improvements of Software V1.70: 

since Function 

V1.60 R&S VSE-K106 : Uplink measurement didn't work with VSE Basic Edition. This issue is 
solved. 

Improvements of Software V1.62: 

since Function 

V1.60 Installation on some Windows systems didn't work due to missing files. This issue is solved. 

V1.60 Improved startup speed when using floating licenses instead of local dongles. 

V1.61 Deskew settings had no effect on connected R&S® RTP devices. This issue is solved. 

 

 



Improvements of Software V1.61: 

since Function 

V1.50 R&S VSE-K70: Remote commands INP:IMP? and INP:IMP:PTYP? did not work. This issue is 
solved. 

V1.40 R&S VSE-K70:  “Meas only if Pattern Symbols Correct” functionality did not work for short 
patterns. This issue is solved. 

V1.30 R&S VSE-K10: When using EDIT→ COPY TO CLIPBOARD to transfer the results of 
TRANSIENT SPECTRUM TABLE or MODULATION SPECTRUM TABLE the limit check 
verdict was always shown as FAILED. This issue is solved. 

V1.50 R&S VSE-K96: After recall, Cyclic Prefix and Preamble settings were sometimes overwritten 
by the content of the configuration file used. This no longer happens. 

V1.50 R&S VSE-K96: After loading an I/Q file, the capture length is now always automatically set to 
the length of the I/Q file content. 

V1.50 R&S VSE-K96: Loading the same XML file twice no longer leads to unloading the OFDM 
configuration. 

V1.50 R&S VSE-K96: Markers are now also transferred to new channels when using the "Duplicate 
Channel"-functionality. 

Improvements of Software V1.60: 

since Function 

V1.50 I/Q Analyzer: During I/Q Vector ASCII Trace Export, the I-values were sorted in ascending 
order. This issue is solved and these values are not sorted anymore. 

V1.50 R&S VSE-K106: Controls for "EUTRA CRS Sequence Info" and "EUTRA PRB Index" were 
corrupt and no value could be selected. This issue is solved. 

  



1.4 Known Issues 

The following table lists the known issues and indicates since which version the issue 

could be observed: 

since Function 

V1.10  

V1.70 R&S VSE-K6: Cumulative statistics for pulse-pulse values are always calculated with the 
default reference pulse setting.  Non-default settings are only applied to the current capture 
statistics. 

V1.70 R&S VSE-K146: For phase-coherent MIMO measurement with multiple NRQs and NRQ 
firmware earlier than 02.20.19111801: High power values for the most recently captured I/Q 
capture buffer and power spectrum measurements 

V1.70 R&S VSE-K146: For phase-coherent MIMO measurements with multiple NRQs and NRQ 
firmware earlier than 02.20.19120202: Analysis results of first I/Q capture may return "sync 
failed". 

V1.70 R&S VSE-K146: For phase-coherent MIMO measurements with multiple NRQs: Measuring 
with external trigger may not work for subcarrier spacings larger than 30kHz. 

V1.50 LTE MIMO in combination with option K544 (User Defined Frequency Response Correction) 
results in an incomplete measurement. The capture does not finish.  

V1.05 I/Q Vector display may slow down the R&S VSE when choosing a long record length. 

V1.10 R&S VSE-K6: The following remote control command is not available: 

[SENSe:]FREQuency:CENTer:STEP 

V1.10 Saving and recalling Matlab files (*.mat) only supports ASCII compatible file names unless 
activated in Windows OS.  

In order to allow Unicode characters in file names, make sure to enable support for 8.3 file 
names on the drive(s) the file is being read from or exported to. For more information please 
refer to this MSDN:  

https://support.microsoft.com/de-de/help/121007/how-to-disable-8.3-file-name-creation-on-
ntfs-partitions 

 

The following table lists known issues with supported instruments and additional 

software: 

Function Instrument 
/ Software 

FW/SW  
Version 

R&S VSE-K100/104: Using the current R&S®FSV or R&S®FSW 
firmware, the Frame Start Offset calculation has an uncertainty of 
+/- 100 ns. 

R&S®FSV 

R&S®FSW 

all 

K72: Using the current R&S®FSV or R&S®FSW firmware, the 
Trigger to Frame calculation has an uncertainty of +/- 100 ns. 

R&S®FSV 

R&S®FSW 

all 

1. The Auto Level routine does not finish when connected with an 
R&S®RTO. 

2. The Reference Level setting does not work reliably. 

R&S®RTO FW 2.6x.x 

FW 2.7x.x, 

FW 3.4.x.x 

The R&S VSE software may stop working in random situations if 
Visa packages of different vendors are installed in parallel on the 
PC. Removing the ambiguity solves this issue. 

Any VISA  

Using R&S®Visa (V5.5.4.0) may cause the R&S VSE to stop 
measuring I/Q data. The issue was observed using the 
Waveform Mode of the RTO (default in R&S VSE-K6) or with 
high traffic on the LAN connection. 

R&S®VISA 5.5.4.0 

K7: There is a carrier offset of up to 120 Hz in RF spectrum when 
using the Waveform mode in case of an ABW < 1,6 kHz. Please 
use the IQ mode for small bandwidths. 

R&S®RTO 

R&S®RTP 

all 

https://support.microsoft.com/de-de/help/121007/how-to-disable-8.3-file-name-creation-on-ntfs-partitions
https://support.microsoft.com/de-de/help/121007/how-to-disable-8.3-file-name-creation-on-ntfs-partitions


1.5 Modifications to the Documentation 

The current documentation is up-to-date. 



2 Software Installation 

The software installation file for the R&S VSE is one file including the main version 

number e.g. VSESetup_V1.30.exe. It will be referred to as VSESetup.exe later in the 

text. The file can be found on the Rohde & Schwarz web page. 

 
  

  
The R&S VSE can only be installed on the 64 Bit Version of Windows 7 or 

Windows 10. Windows 10 64 Bit is recommended. 

2.1 Installing the Software on your PC 

Performing the installation on your PC: 

The R&S VSE needs some additional software components to run properly. 

The following components are needed: 

● Microsoft .NET Framework Version 4.0 

● VISA (Virtual Instrument Software Architecture) 

Install Microsoft .NET Framework 

The R&S VSE installer will try to install the .Net 4.0 from the internet.  

 

Install VISA 

It is necessary to install VISA (Virtual Instrument Software Architecture) to access 

instruments connected to the PC via IEEE or LAN bus. 

Please use the R&S VISA provided with the VSE installer or visit www.rohde-

schwarz.com/rsvisa to get the latest version 

 

Installing VSE 

Please save the VSE Installer on your hard disc in order to install the Software  

http://www.rohde-schwarz.com/rsvisa
http://www.rohde-schwarz.com/rsvisa


2.2 Installing Software Options 

2.2.1 Software options included in base software 

The K7 application software package is included in the base software. Therefore, it 

does not have a separate item in the installer to be selected. 

2.2.2 Other Firmware Options within the VSESetup.exe File 

 General VSE Options 
The R&S VSE-K70 and other application software packages have their own installation 

item and are therefore added to the selection list during the software update. Ensure 

that the checkboxes are checked  if installation is requested. 

 ETL-K470 CDR License 
The Convergent Digital Radio (CDR) feature available in the R&S VSE requires an 

Ethernet connection to an R&S ETL. The R&S ETL must have a valid R&S ETL-K470 

CDR license and a firmware version 3.51 or later. 

To use the R&S ETL CDR, you have to install the following R&S VSE packages: 

● R&S VSE Vector Signal Explorer software 

● R&S VSE K96 OFDM signal analysis 

● Activate R&S ETL-CDR K470 

When you activate the R&S ETL-K470, R&S VSE runs in an exclusive CDR mode. 

CDR mode is designed to analyze CDR signals within the VSE. Therefore, it has the 

following restrictions: 

● You can only use the I/Q analyzer and the OFDM analysis for CDR signals. Using 

other (optional) applications is not possible, even if you have a valid license for 

them (for example on an R&S FSPC dongle). 

● You can only connect to an R&S ETL. Connecting to other instruments otherwise 

supported by the R&S VSE is not possible. 

● You can only connect to one R&S ETL at a time. 

2.2.3 Enabling Options by Entering Option Key Codes 

 
  

  This section can be skipped if the option key was entered once. 

   
To activate application software packages, you must enter a license key for validation.  

If a XML-file with an option key was sent to you see the install description below. 

The license key is in the device certificate or delivered as a part of the software 

package. The process is performed in the following steps: 



1. Go to the "Help" menu 

2. Press the "License" menu item. 

3. Press the "Install Option" Button 

A dialog box is displayed. 

4. Enter the option key number. 

5. Press "ENTER". 

After a successful validation the message "Option Key valid" is displayed. If the 

validation failed, the option software is not installed.  

6. Restart the software. 

 

 

Installation of options via XML-file 

1. Go to the "Help" menu. 

2. Press the "License" menu item. 

3. Press the button "Install Option by XML" button. 

A file browser is displayed. 

4. Select the path to the XML file (e.g. network drive or USB stick). 

5. Press "Select". 

After a successful validation the message "Option Key valid" is displayed. If the 

validation failed, the option software is not installed.  

6. Reboot the device. 

 



3 Customer Support 

Technical support – where and when you need it 

For quick, expert help with any Rohde & Schwarz equipment, contact one of our 

Customer Support Centers. A team of highly qualified engineers provides telephone 

support and will work with you to find a solution to your query on any aspect of the 

operation, programming or applications of Rohde & Schwarz equipment. 

Up-to-date information and upgrades 

To keep your software up-to-date and to be informed about new application notes 

related to your software, please send an e-mail to the Customer Support Center stating 

your software and your wish. We will take care that you will get the right information. 

Europe, Africa, Middle East 
Phone +49 89 4129 12345 
customersupport@rohde-schwarz.com 

North America 
Phone 1-888-TEST-RSA (1-888-837-8772) 
customer.support@rsa.rohde-schwarz.com 

Latin America 
Phone +1-410-910-7988 
customersupport.la@rohde-schwarz.com 

Asia/Pacific 
Phone +65 65 13 04 88 
customersupport.asia@rohde-schwarz.com 

China 
Phone +86-800-810-8828 / +86-400-650-5896 
customersupport.china@rohde-schwarz.com 

 

mailto:customersupport@rohde-schwarz.com
mailto:customer.support@rsa.rohde-schwarz.com
mailto:customersupport.la@rohde-schwarz.com
mailto:customersupport.asia@rohde-schwarz.com
mailto:customersupport.china@rohde-schwarz.com

